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Installation Quick Reference 

The steps for installation Galileo Desktop 2.6 / Smartpoint v7.0 differ depending on your current 
configuration. Refer to the appropriate section below for your configuration. 

Upgrading Galileo Desktop and Smartpoint 
1. Close existing, installed products and applications.  

Note: When upgrading from a version prior to Galileo v2.4 it may be necessary to manually 
remove the application before installing the current version. 

2. Check compatibility with existing add-on applications before upgrading to a newer Galileo 
Desktop, Travelport Smartpoint bundled version. 

3. Follow the steps in Pre-installation Requirements (page 5) to back up your data files. 

4. Follow the steps in Upgrading from an Earlier Version (page 8). 

First-time Installation 
1. Refer to hardware and software requirements to ensure your configuration meets the minimum 

requirements (page 2). 

2. Install Secure Socket Layer (page 4), if it is not already installed. 

3. Ensure that your firewall is configured to allow access to Travelport (page 7). 

4. Follow the steps in Installing for the First Time (page 8). 

Other Installation Configurations 
For any of the above installations, the following configurations are available: 

 To configure the application to automatically open Galileo Desktop in the Terminal Window mode 
at startup, follow the steps in Terminal Window Startup Installation (page 23). 

 For Citrix/MTS installation instructions, refer to page 26. 
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Interactive Install 

This installation guide applies to the interactive install. The interactive install checks to determine if pre-
requisites exist. If not, the installation will notify the user and terminate.  

When the pre-requisites are fulfilled, InstallShield will install the updated Galileo Desktop software and 
Travelport Smartpoint. You are not required to remove the older versions before installing the latest 
versions.  

Note:  

Existing installed products and applications should be closed before attempting to upgrade. Please also 
check compatibility with existing add-on applications before upgrading to a newer Galileo Desktop, 
Travelport Smartpoint bundled version. 

The user should check the application compatibility with the provider before upgrading to a newer Galileo 
Desktop version. Galileo Desktop add-on applications should be verified after upgrading. 

When upgrading from a version prior to Galileo v2.4 it may be necessary to manually remove the 
application before installing the current version.  

Software and Support Documentation 

Refer to your regional portal for the latest version of the Galileo Desktop and Smartpoint bundled 
installation file. 

Download the installation file and installation guide from your regional portal.  

 Installation file is located in Galileo/Software/Basic Software/Galileo Desktop. 

 Installation guide is located in Galileo/Software/Installation Manuals/Galileo Desktop.  

Software and Hardware Requirements 

Client Installation 

Supported Operating System 
Windows Server 2003 SP2 
Windows Server 2008 (not supported on Server Core Role)  
Windows 7  
Windows Server 2008 R2 (not supported on Server Core Role)  
Windows 7 SP1  
Windows Server 2008 R2 SP1 
Windows 8  

Supported Architectures 
x86 
x64 
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Hardware Requirements 
Minimum processor: Pentium 1 GHz or higher  
Minimum memory: 512 MB RAM or more  
Minimum disk space: 

x86 – 850 MB 

x64 – 2 GB 
Recommended processor: Pentium 2 GHz or higher 
Recommended memory: 2 GB RAM or more 
Recommended disk space: 3 GB 
Recommended graphics processor supporting DirectX 9 

Prerequisites 
Windows Installer 3.1 or later 
Internet Explorer 7.0 or later 
Galileo Desktop 

Terminal/Remote Desktop Services/Citrix XenApp Installation  

Supported Operating System  
Windows Server 2003 SP2 with Terminal Services  
Windows Server 2008 with Terminal Services  
Windows Server 2008 R2 or higher with Remote Desktop Services  
Citrix XenApp 5.0 or higher  

Supported Architectures 
x64 

Hardware Requirements  

Hardware requirements are highly dependent upon user profiles, number of concurrent users and 
other applications running on the server. The following are minimal guidelines. 

Minimum processor: Xeon 1.8 GHz dual core  
Minimum memory: 8 GB RAM or more  
Minimum disk space: 2 GB 

Prerequisites 
Windows Installer 3.1 or later 
Internet Explorer 7.0 or later 
Galileo Desktop 
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Prerequisites 

Introduction 
Galileo Desktop is a global reservation system providing access to tools for shopping and booking all air, 
hotel, car rental and other travel-related products available through the Galileo global distribution system 
(GDS). 

Galileo Desktop is a travel sales management solution offering both Focalpoint and Viewpoint. Galileo 
Desktop has been developed to work in standardized Windows® software environment. 

Secure Socket Layer Requirements 
SSL (Secure Sockets Layer) is a commonly used protocol for managing the security of a message 
transmission on the Internet. This installation requires that SSL is installed on the system. If you do not 
already have SSL installed refer to ASK Travelport Answer ID 15294 for information on completing the 
install process. 

Before You Begin 
 If you are running Focalpoint 3.2, or Focalpoint 3.0.18A, remove the icon from your desktop 

(right-click the icon and select Delete). 

 Make a note of your Client ID and IP configuration settings. Go to the Control Panel/Galileo 
TCP/IP settings for this information. 

 Disable any anti-virus software you may have running. Anti-virus software may prevent registries 
from being updated. 

 Do you require/have administrative privileges? 

 Is the resolution set to at least 1024x768? 

 Is the color depth at least 256 colors? 

 Is there sufficient disk space? 

 Close Galileo Desktop and Smartpoint before beginning installation. 
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Pre-installation Requirements 
During the installation, you will encounter the Pre-installation requirements dialog, and must click Yes to 
confirm before you can proceed with the installation. 

Note: If you are not familiar with how to backup files, please check with your manager/IT manager. 

 

The sections below will help you find the files you want to backup. When the installation is complete, you 
are reminded to reinstate these files. 

File locations for each question are listed below. 

C:\FP\machine - dat32com.ini file 

The Machine directory contains a file called dat32com.ini, which contains the user’s Client ID. 
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Have you backed up your data files? 

File Type Location 

Replay Files \FP\REPLAY\*.* 

Relay Files These files are stored in multiple places.  

 QManager scheduler dat file will be in \fp\datadir\users\xx (where X is the 
user ID in the splash screen), or \fp\datadir\wstn when not used. 

 Queue Distribution lists, end with a .QDL extension and are typically stored 
in \fp\swdir. 

Scriptwriter Plus 
Files 

\FP\DATADIR\SWPLUS\SCRIPTS\*.* 

Browser Script 
Files 

\FP\DATADIR\SCRIPTS\*.* 

Have you saved your preferences and settings? 

File Type Location 

Focalpoint Config 
File 

\FP\DATADIR\WSTN\focalpoint.config.xml 
\FP\DATADIR\USER\users\focalpoint.config.xml 

Scriptwriter Run 
Group 

These are typically store in \fp\datadir\users\xx (where X is the user ID in the splash 
screen) or \fp\dataid\wstn when not.  
These files are typically named grpX.swr (where X is the # of groups created) 

Have you backed up your Pkeys? 

C:\FP\Datadir  

The Datadir directory usually contains the Programmable Keys and the User Profile configuration. The 
User Profile setting should be saved under a Profile Name, as failure to enter a name will result in the 
default directory (WSTN) being modified and potentially corrupted. 

Note: The location refers to the default location and customized install locations may vary. 

File Type Location 

Apollo Keys \\FP\DATADIR\PKEYS\*.PKEYS.XML 

Galileo Keys \\FP\DATADIR\PKEYS\*.PKEYS.XML 

Galileo Desktop \\FP\DATADIR\PKEYS\*.PKEYS.XML 

Have you backed up any Viewpoint Customization? 

I have modified non-version controlled files, what steps do I need to take? (For example, I have added a 
right-click menu into the pnr.html file which launches one of my files.)  

Take a copy of the code that has been added to the file. After the installation, this code can be added 
back into the appropriate file within Galileo Desktop. The Galileo Desktop file structure has changed so it 
is important to ensure that the correct file is being edited. 

Have you backed up your script library? 

C:\FP\swdir\CustomViewpoint\LocalScripts 

 



 Travelport 

Travelport Smartpoint v7.0: Technical Installation Guide Page 7 

Note: Customized script locations may vary. 

File Type Location 

Galileo Java 

Script Library 

\FP\SWDIR\CustomViewpointGalileo\CustomViewpointGalileo 

Java Script 

Library Val 

Files 

\FP\SWDIR\CustomViewpointGalileo\CustomViewpointGalileo\gdia_ValFiles 

Firewalls  

Firewalls and routers must permit the following in order to access Travelport's Apollo and Galileo hosts in 
a production environment. 

UDP and TCP traffic from Galileo Desktop to and from the following Travelport networks:  

 57.8.81.0 255.255.255.0 (24 bit mask)  

 UDP ports 5068 and 5069  

 TCP ports 2748 and 2749  

Note: If you need access to "copy" or "test" Apollo or Galileo hosts, you need to permit access to the 
following in addition to the networks and ports listed above:  

 57.8.72.0 255.255.255.0 (24 bit mask)  

 TCP port 22748 and 22749 

For more information about firewall specifications, refer to your regional portal.  
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Galileo Desktop / Travelport Smartpoint – Installing For the First Time 
or Upgrading from an Earlier Version 

Note: SSL Client must be installed before installing for the first time. Refer to Secure Socket Layer 
Requirements (page 4). 

Download the Smartpoint and Galileo Desktop bundled installation file from your regional portal. 

1. Click Save and then select the location to save to.  

 

Save progress screen. 

 

2. From the saved location, click on file name (or icon if saved to the desktop) to install. 
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3. Click I Agree to accept the License Agreement.  

 

Installation progress screen is displayed. 
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4. Pre-installation task list is presented. Click Yes. Refer to Pre-installation Requirements for more 
information. 

 

Preparing to Install… progress screen is displayed. 

 

Installation progress continues. 
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InstallShield Wizard Preparing to Install… screen is displayed. 
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5. Click Next. 

 

6. Click Yes to accept the License Agreement. 
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7. Choose start up preference and click Next. For more information about Terminal startup, refer to 
Terminal Window Startup Installation on page 23. 

 
 

8. Choose boot-up preference and click Next. 
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9. Highlight desired language(s) and click Next. You can select multiple languages by holding the 
CTRL key and selecting additional languages from the list.  

 

10. Use default directory settings and click Next. To configure Internet settings, first select the 
Internet button. 
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11. Complete the connection information if not previously configured. 
a. Enter the Client Identifier. A Client ID is required per workstation. Please contact your 

Travelport Account Manager to order new Client IDs. 
b. For Keyboard Mode, select Apollo / Galileo Mapped. 
c. For the Configuration Server address, enter the addresses based on your connection type. 

SSL  Primary IPCS Address = 127.0.0.1 
Secondary IPCS Address = 127.0.0.1 

CMVPN Primary IPCS Address = 57.8.81.13 
Secondary IPCS Address =57.8.81.113 
Primary=198.177.164.151 
Secondary=198.177.164.152 

d. Click OK. 

  

12. Click OK. 
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13. Click OK. 

 

 

Please note:  The following three Select Features screens differ depending on which system, Galileo or 
Apollo, the agent is using.  Examples have been given for both.   

Once past the three Select Features screens, at the configuration screen, both Galileo and Apollo follow 
the same path. 

For Galileo® users  

a. Click Next. 
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b. Click Next. 

 

c. Click Next. 

 



 Travelport 

Travelport Smartpoint v7.0: Technical Installation Guide Page 18 

For Apollo users 

a. Click Next. 

 

b. Click Next. 
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c. Click Next. 

 

The software begins to install for either Galileo or Apollo. 
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14. Click Next. 

 

15. Click Finish. 
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Installation progress screens are displayed.  

 

 

16. Click Next. 
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17. Make setting selection and click Close. 

 

18. Click OK then, restart your computer as directed. 
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Terminal Window Startup Installation 

The Terminal Window Startup Installation is an advanced installation option that automatically opens 
Galileo Desktop in the Terminal Window mode on startup. This option disables the display of the splash 
and logon screens, which display by default during the Galileo Desktop startup. 

This installation option can be used if a customized startup script is used, or any functionality is modified 
in Galileo Desktop that conflicts with the use of the splash screen or logon screen. 

This installation uses the same basic process as the Basic Installation. However, certain installation 
selections are required, as well as additional steps to configuring the Viewpoint Options menu. 

1. Complete Steps 1–6 of the Galileo Desktop / Travelport Smartpoint – Installing For the First Time 
(page 8). 

2. For Step 7 of the Galileo Desktop / Travelport Smartpoint – Installing For the First Time, select 
the Terminal windows (Focalpoint) visible at startup option. 
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3. For Step 8 of the Galileo Desktop / Travelport Smartpoint – Installing For the First Time, select 
the Start Galileo Desktop automatically option. 

 

4. Complete the rest of the Galileo Desktop / Travelport Smartpoint – Installing For the First Time 
steps. 

5. After installed, display the Itinerary Window (Viewpoint) mode. 

6. From the Tools menu, select Options to display the Viewpoint Options window. 

7. Select the General tab. 

 

8. Clear both the Show splash screen on startup and Show logon screen on startup check boxes. 
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9. If a startup script is desired, change from Viewpoint to the Terminal Window (Focalpoint) mode, 
and select Set Workstation Defaults from the Options menu. 

10. In the Set Workstation Defaults dialog box, browse or enter the path for the path for the Startup 
Script. 

 

11. From the File menu, select Save to save the new settings. 

12. The Terminal Window displays, and the startup script launches and runs. 
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Citrix/MTS Installation 

The following instructions are intended as an aid for installing and configuring Galileo Desktop v2.6 / 
Travelport Smartpoint, to function in a multi-user environment from a Citrix Server or Microsoft Terminal 
Server (MTS). 

These procedures will vary depending on site requirements and server administration differences. 

Note:  This guide was created in response to customer requests. Citrix Server and Microsoft Terminal 
Server are not supported in Galileo Desktop/ Travelport Smartpoint; however, these environments may 
be supported by customers, vendors, or NDCs/SMOs. Contact your regional support organization for 
more details. 

Requirements 
These instructions support the installation of Galileo Desktop/ Travelport Smartpoint in a Citrix and MTS 
environment for either: 

 Thin-client terminals (if used). 

 Windows-based workstations or other clients supported by Citrix client software. 

The following hardware and networking must be installed and functioning before Galileo Desktop is 
installed and configured: 

 Citrix MetaFrame Presentation Server 4.0.  

 Microsoft® Windows® 2003 or higher.  

 Windows 2003 Server or Advanced Server. 

 Windows Terminal Server with MetaFrame Presentation Server, Version 4.0 or higher.  
Note:  If using thin-client terminals, MetaFrame must be installed. 

Assumptions 
This guide is intended to document the process for installing a Citrix server in most environments. 
However, these procedures cannot duplicate the process that will be required for every installation. This 
guide assumes that: 

 Galileo Desktop/ Travelport Smartpoint will be installed on the Citrix server. 

 The drive locations will vary depending on the server environment. For this document, the 
following standards apply:  

o Drive C designates the local drive of the Citrix server. 
o Drive A designates the floppy drive. 
o Drive D designates the CD-ROM drive. 
o WINDOWS designates the Windows directory on the Citrix server.  
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Preparing the Citrix Server 
To prepare the Citrix server for the Galileo Desktop/ Travelport Smartpoint installation, you must be 
logged on with Administrative authority to the server itself. This procedure also assumes that the Citrix 
environment is already running. 

1. Right-click My Computer on the Windows Server Desktop. 

 

2. Select Manage. The Computer Management window displays. 

3. Select Local Users and Groups then, select Users to display the user list. The following 
example shows default remote user names of Remote00 through Remote14.  
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4. Double-click on the user name for each user who will share Galileo Desktop/ Travelport 
Smartpoint to display the User Properties dialog for that user.  

 

5. Click the Profile tab. 

 

6. In Home folder, select Local path. The location of the Local Path field will vary depending on your 
administration. 

7. In Local Path, enter C:\USERS\<username>, where <username> is the actual user name.  
Note: You must repeat step 7 for all users that require profiles. 



 Travelport 

Travelport Smartpoint v7.0: Technical Installation Guide Page 29 

8. Click the Terminal Services Profile tab. 

 

9. In Local Path, enter C:\USERS\<username>. 

10. Click OK to redisplay Computer Management. 

11. Repeat this procedure for each Galileo Desktop client workstation. 

Preparing the Client Package on the Citrix Server 
The procedure for configuring the client workstation depends on whether a thin client workstation, 
Windows workstation, or Web client is used.  

If you are configuring Galileo Desktop / Travelport Smartpoint for a thin client workstation or a Web client, 
you may need to install the Citrix Presentation Server Client Package Version 10.0, depending on your 
environment. The required type of client may also vary depending on your specific connectivity 
requirements.  

You can download the Client Package from your source, if available. However, it is recommended to 
download the client directly from citrix.com to obtain the most current version of the Client Package. 

Installing Galileo Desktop / Travelport Smartpoint 
In Citrix environments, Galileo Desktop must be installed through the Add or Remove Programs feature to 
ensure that is registered as a shared application. Do not use the Command Prompt method described in 
the Basic Installation. 

Note: Screen shots may vary depending on whether you are installing for Apollo or Galileo. 

To install Galileo Desktop / Travelport Smartpoint: 

1. Insert the Galileo Desktop / Travelport Smartpoint CD into the appropriate server drive or 
download from a location provided by your administrative contact or your Apollo or Galileo 
account representative. 
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2. Click Start on the Windows Desktop, then click Control Panel. 

 

3. In the Control Panel folder, double-click the Add or Remove Programs icon to display the Add 
or Remove Programs dialog box. 
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4. Select Add New Programs  icon to display the Add New Programs dialog box. 

 

5. Click CD to display the Installation Program from CD-ROM dialog box. 

 

6. Click Next to display the Run Installation Program dialog box. 
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7. In Open, type the path to Setup.exe Galileo Desktop / Travelport Smartpoint CD. 

Notes:  

 The CD-ROM or disk drive may be different for your workstation. 
 The CD can be run from a server when necessary. 

8. Click Finish. The Galileo Desktop / Travelport Smartpoint Installer displays. 

9. Click Next to run the Galileo Desktop / Travelport Smartpoint installation. The Install Products 
window displays. 

 

10. Click Galileo Desktop to display the Welcome window. 

Notes: 

If a previous version of Galileo Desktop is installed on your workstation, this version will be 
uninstalled before the Welcome window displays. 

It is highly recommended that in a Citrix environment all required software is previously 
installed prior to installing Galileo Desktop; therefore, there is no need to select additional 
software. 

11. Continue with the Basic Installation. 

12. When you have completed the Basic Installation, launch Galileo Desktop / Travelport Smartpoint 
on the Citrix server to ensure it is functioning correctly. 

13. Continue with the following sections of the Citrix/MTS Installation. 
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Configuring Galileo Desktop / Travelport Smartpoint 
Galileo Desktop / Travelport Smartpoint must be configured on the server to permit use by client 
machines. Configuration involves copying Galileo Desktop / Travelport Smartpoint directory information 
into the User home directory of each client workstation, and confirming or modifying the networking 
information. 

Setting Up User Accounts for Configuration 

Configuring user accounts for Galileo Desktop varies depending on the status of the account. Follow 
these procedures to prepare user accounts for configuration. 

 If the client workstation is new and has not been logged on to the Citrix server, log on from the 
workstation before configuring Galileo Desktop / Travelport Smartpoint. Logging on to the server 
will create a Windows directory for that user. 

 If the client workstation has been logged on to the Citrix server, before Galileo Desktop / 
Travelport Smartpoint was installed, the Windows directory has already been created for that 
user. However, slightly different modifications are needed for the files in the window directory. 

Configuring the Directory Structure for Galileo Desktop / Travelport Smartpoint 

Within this procedure, ANON12 is used at the sample username and indicates the Windows 2003 
identification for an individual client machine. User subdirectory designates the home directory for any 
client machine. 

Duplicating the Machine Directory 

1. In the Windows 2003 Explorer window, locate the C:\USERS\ subdirectory. This subdirectory 
should contain the user directories for client machines that were created when MetaFrame was 
configured on the Citrix server. In the graphic below, the 15 users display the default names 
Anon000 through Anon14. 

 

2. Right-click on C:FP\MACHINE\ and select Copy. 
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3. Open the User subdirectory of the first client machine. The graphic below displays the Anon012 
User subdirectory as an example. 

 

4. Right-click within the User subdirectory and select Paste, to duplicate the Machine subdirectory. 

5. Repeat the copy process for each remote user. 

Modifying DAT32COM.INI 

1. Open the first Machine subdirectory that you have just copied to the User subdirectory. 

2. Double-click DAT32COM.INI to display the file in Notepad format. 

 

3. The Client Identifier line should list the client identification entered during installation. This 
procedure uses XXXXXX as the client identifier. 

4. Change both Client Identifier = XXXXXX lines to the user’s client identification. This 
defines the connections you set up when you installed Galileo Desktop. 

5. Select Save from the File menu. 

6. Close the file. 
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7. Repeat the procedure for each remote client. 

Modifying WIN.INI 

1. Open the Windows directory in the C:\USERS\<username> subdirectory where <username> is 
the actual user name.  
Note: There will be no Windows directory in the <username> subdirectory if the client has not 
already logged in to the Citrix server. The user must log into the Citrix server at least once before 
you can modify the win.ini. See Setting Up User Accounts for Configuration (page 33) for more 
information. 

2. Open WIN.INI. 

 

3. Copy all of the Focalpoint information from the WIN.INI (C:\WINDOWS\WIN.INI) to the client’s 
WIN.INI. The information to be duplicated is shaded in the graphic above. Continue to Step 16 
when the duplication is completed. If the client was logged in to the server after Galileo Desktop 
was installed, all of the Focalpoint information should already be in the client’s WIN.INI. 

4. The Machinedir line displays C:\USERS\MACHINE\. Enter the individual client identification into 
the path. For example, the Anon012 user name should display as 
C:\USERS\ANON012\MACHINE 

5. Confirm that the paths to the Galileo Desktop directories match the paths displayed in step 10 
(page 14) of the installation procedure. In the sample graphic, C:\FP\SWDIR and C:\FP\DATADIR 
display. 

6. Select Save from the File menu. 

7. Close the file. 

8. Repeat the WIN.INI modification for each remote user. 



 Travelport 

Travelport Smartpoint v7.0: Technical Installation Guide Page 36 

Publishing Galileo Desktop / Travelport Smartpoint 
Use the following procedure to publish Galileo Desktop / Travelport Smartpoint on both Windows Server 
2003 Standard and also MetaFrame Presentation Server 4.0.  

1. Log on to the Citrix Farm at Programs > Citrix > Management Consoles > Presentation 
Server Console. 

2. Under the current farm, right-click Applications, and select Publish Application. 

 

3. The Application Publishing Wizard displays. 

 

4. In Display Name and Application Description, enter the desired name and description for Galileo 
Desktop. 
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5. Click Next to display the Specify What to Publish dialog box. 

 

6. Select Application. 

7. In Command Line, enter the path for Viewpoint.exe, or click Browse to locate the executable. In 
this example, the executable is located in: C:\FP\SWDIR\VIEWPOINT.EXE. 

8. The Working Directory field automatically displays as C:\FP\SWDIR. 

9. Click Next to display the Program Neighborhood Settings dialog box. 

 

10. Specify a neighborhood folder or Start Menu and shortcut options, as desired. 
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11. Click Next to display the Specify Application Appearance dialog box. 

 

12. Click the Session Window Size arrow, and select 800x600 or greater. 

13. Modify colors and application startup settings, as desired. 

14. Click Next to display the Specify Client Requirements dialog box. 

 

15. Unless modified settings are preferred, do not modify this dialog box. 
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16. Click Next to display the Specify Application Limits dialog box. 

 

17. Unless different settings for concurrent instances or the CPU priority level are desired, do not 
change the default settings. 

18. Click Next to display the Configure Access Control dialog box. 
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19. Click Next to display the Specify Servers dialog box. 

 

20. From the list of Available Servers, select the servers to be run for Galileo Desktop / Travelport 
Smartpoint. 

21. Click Add to move the selected servers to the Configured Servers column. 

22. Click Next to display the Specify Users dialog box. 

 

23. Click the Look in arrow to select the desired domain or server. 

24. Select the users for that domain or server, and click Add to display the users in the Configured 
Accounts list. These users now have permission to access Galileo Desktop. 

25. Repeat Steps 21–22, as necessary, for all servers or domains associated with Galileo Desktop.  
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26. Click Next to display the Specify File Type Associations dialog box. 

 

27. Click Finish to complete publishing Galileo Desktop. 
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Confirming Galileo Desktop / Travelport Smartpoint Connectivity 
There are two ways confirm connectivity: 

1. Launch an Internet Explorer browser and test Galileo Desktop / Travelport Smartpoint via the 
Web Client by entering the Citrix server name. The Citrix Web interface displays. If the Web 
Client is not installed, you can download it off the server or directly from Citrix.com. 

2. Open a Galileo Desktop / Travelport Smartpoint session from the client workstation. 

If the connection was successful a Download Successful message displays at the lower left in the status 
bar to confirm that the HCM has connected to the IPC. 

If the connection was not successful, a Failed to Open message displays. 

 

Mapping the bundled installer for use in APAC  
 

1. Installation of ESD bundle (ie GD2.6 and SP2.4),  
a. Checks the requirement eg. Service packs and DotNet 
b. Backing up existing data 

*Assuming item 1a and 1b are already completed for now. 

2. Install APAC CVP Scripts and localization settings  
a. Checks the Region (Asia or Pacific)  

i. If Asia, select installation country – China, Hong Kong, Malaysia, Philippines, 
Singapore and Taiwan 

1. Install the APAC CVP scripts (CVP201_APAC_Release_28.exe) 
2. Install the new toolbar  (C:\FP\SWDIR\vptoolbar.xml) 
3. Install the localization stuff eg. Pkeys, additional vptoolbar.xml or scripts 

or applications eg Ticket Wizard used in Hong Kong, China and Taiwan. 

*Assuming that SMO provides the zip of the localization stuff so that we can append 
the required items onto C:\FP folder.  

3. Install SSLVPN 
4. Option to install GPM. 
5. Delete temporarily files and restart.  
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Troubleshooting 

Smartpoint App Not Responding 
In some cases, when you download a Smartpoint installation file (the setup.exe file or a zip file) from the 
internet, it becomes blocked on the computer. This is a Windows security feature that sometimes occurs 
when files are downloaded. When this occurs, you can double-click on the .exe file to run the installer and 
Smartpoint will install successfully, but all files installed in the Smartpoint application directory will be 
blocked.  

After this blocked installation, when you try to run Smartpoint you will see this error after start-up: 

 

 

There could possibly be other reasons why this error might appear, so it cannot be automatically 
assumed that it was from a blocked installation file. Verify the following: 

 

1. Does the error occur soon after Smartpoint starts (for example, after you sign on to the host)? 
2. If you starts Smartpoint using “Run as administrator” (you may require assistance from a user 

with administrative rights to do this), does this resolve the problem for this single use of 
Smartpoint? 
 

 

 

3. If both of these are true, then as a final check, right-click and select “Properties” for one of the 
DLL files (e.g. “0100.00.AirAvailability.dll”) found within the Smartpoint application folder located 
here: 
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C:\Program Files\Travelport\Smartpoint 

or  
C:\Program Files (x86)\Travelport\Smartpoint 

 

If the resulting dialog includes an “Unblock” button, as shown here, then this confirms the problem: 
 

 

To resolve this, it will be necessary to uninstall Smartpoint, and then re-install using a setup.exe file that 
you have confirmed is not blocked. Confirm the executable file is not blocked by right-clicking on the file 
and select Properties. Then, if present, click the Unblock button. 

 

 


